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Preface

Hello my name is Donald May and welcome to my book on UnrealScript.
The purpose of this book is to teach you how to program in the UnrealScript
scripting language. UnrealScript was developed by Tim Sweeny as the script-
ing language for the Unreal Engine. Specifically this book will talk about Un-
realScript as used in the Unreal Development Kit (UDK). This book should
also be useful for those using UE3 licenses however I will not focus on func-
tionality that is not available to the broader UDK audience.

The book is not a guide on how to use the editors in UDK or how to go about
making any particular type of game. Rather this book aims to improve
your UnrealScript programming ability and to teach you how to read and
comprehend existing UnrealScript. We will also cover a number of tools for
editing, debugging, and compiling UnrealScript.

At the time of this writing UDK is in beta and I see no reason to believe that
for the immediate future it will not remain in perpetual beta. This means
that you should not use it for mission critical tasks and that not all features
will be fully tested. Some features may contain bugs and if you are on the
fence about using UDK then you may wish to factor this into your decision
making process. However I can say that by using UDK you will receive one
of the most powerful three dimensional game engines on the market for no
upfront investment.

The lessons in this book will start off rather basic and then focus on spe-
cific programming tasks and the approaches used to solve those problems.
An emphasis will be placed on understanding the concepts behind the code
rather than copying the code verbatim. Topics covered will include basic pro-
gramming concepts, object oriented programming concepts, a brief primer on
three dimensional programming, and a particular emphasis on network pro-
gramming. We will also look at various ways of expanding UDK’s capabilities
using Dynamic Link Libraries (DLLs).
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iv PREFACE

The UDK website contains excellent documentation for UnrealScript, but the
problem is that it is designed for people with significant programming and
specifically object oriented programming experience. This can make learning
UnrealScript a daunting proposition and it this books goal to assume as little
prior experience as possible.

I have been programming for over fifteen years and currently hold a bachelors
degree in Physics with second majors in Computer Science and Mathematics
from Texas A&M University - Commerce. I have been using UDK for around
a year at the time of this writing and have created a number of tutorials
on various UnrealScript tasks. I have programmed two commercial casual
games in C++ using the Popcap Game Framework: Daycare Nightmare:
Mini Monsters and Speedy Solitaire.

I hope you will find this book useful if you are new to programming or just
looking to expand your skills. Remember that programming can be a tedious
and challenging endeavor, but I believe you will find the results worthy of
your hard work! If you come to a concept that you do not understand then
please be patient as often that term will be explained later in the book. So
many concepts in programming depend on each other that sometimes it can
be very difficult to teach or explain a concept without referring to a future
concept. Also if when reading this book you encounter any errors or have
any questions please make note of these issues and contact me! This book
will only improve with your valuable feedback. Also note that sometimes
this book will state my opinion on various programming approaches. If you
disagree with my approach to a particular problem, feel free to use your own!
There are often many different ways to solve any particular problem.



Chapter 1

Getting Started

1.1 Installing UDK

This book assumes that you are using the Unreal Development Kit (UDK) .
To download the Unreal Development Kit you will need to go to http://www.

udk.com/ and follow the download link. New versions are released monthly
so chances are the build of UDK we use in this book will be out of date even
by the time this book is published, however the concepts should remain the
same. This book is using the June 2011 build of UDK although I strongly
recommend using the latest build of UDK available so that you can benefit
from all of the new features. However as I mentioned in my introduction that
UDK is currently in beta so I recommend doing your research. If you are
already using UDK then you may wish to settle on a particular build if you
do not require the latest features or if the release contains breaking changes.
As developers it is our goal to minimize the impact of any breaking changes
and to write our code in a robust enough manner that it can be upgraded
and maintained as UDK changes and evolves.

Once you have successfully installed UDK I recommend taking some time and
learning the various editing tools that UDK contains such as UnrealEd and
the Unreal Frontend??. Unfortunately such discussion is outside the scope
of this book, however the UDK website contains some excellent video tuto-
rials that should get you up and running with the UDK editing environment
quickly.

The UDK contains a powerful visual scripting system called Kismet that can
be used to script level specific logic. It is powerful enough to create various

1
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2 CHAPTER 1. GETTING STARTED

games without the need to touch a single line of UnrealScript which is great
for artists and people who are not very comfortable or familiar with program-
ming. Experimenting with Kismet can be a great way to learn basic concepts
and to gain more familiarity with how the Unreal engine works. Kismet is
not a focus of this book although we will briefly talk about communication
between Kismet and UnrealScript in a later chapter.

I would recommend using Kismet for level specific logic and using Unre-
alScript for game specific logic. Use Kismet if you only need something to
occur in a particular level of your game, but use UnrealScript if you need
something to occur on every level. Kismet in designed to allow your level de-
signers the ability to add functionality without needing to learn UnrealScript,
however it should not be used as a replacement for UnrealScript for code that
is not level specific.

1.2 Choosing an UnrealScript workflow

One of the first stumbling block that a new UDK user interested in Un-
realScript might experience is how to go about editing and creating Unre-
alScript files. UnrealEd does not contain any editor for UnrealScript files
and it will quickly become apparent that we will need some additional soft-
ware.

There are many tools available to create UnrealScript files. Each tool or set
of tools contains different features and your choice of tools will establish a
particular workflow for your project. These tools range from free to fairly
expensive. Your choice should depend on your needs and budget and I will
discuss a number of options so that you can make an informed decision about
which tools to invest time learning.

An Integrated Development Environment (or IDE) contains for the purpose
of this book a source code editor, a debugger, and a script compiler. The
source editor provides a means to edit UnrealScript files and usually provide
syntax highlighting and even code completion functionality. The debugger
provides the ability to set breakpoints in code, watch variables, and to step
through executing statements in order to observe the code behavior. The
compiler will take the UnrealScript files and turn them into files that can
more easily be processed by the Unreal engine. Not all of the tools mentioned
will qualify as an IDE for this reason. Some tools will serve as just the
editor, just the compiler, or just the debugger. We will need all three of
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these components in order to obtain a sufficient workflow. Luckily by simply
modifying the contents of the source folder we will be prompted by UnrealEd
if we would like to compile our scripts or we can compile our scripts using
the Unreal Frontend so there are plenty of ways to compile. That means
primarily we are looking for a source editor and a debugger.

The current popular choice when it comes to an UnrealScript IDE is to use
Visual Studio with the nFringe plugin by PixelMine. Visual Studio is a well
regarded tool within the development community and nFringe allows you to
use Visual Studio to edit, debug, and compile UnrealScript files.

However this combination can have some drawbacks. Visual Studio can be
expensive and while nFringe does not exactly“require”Visual Studio there are
some additional installation steps that need to be performed to make it work.
Additionally at the time of this writing nFringe while free for noncommercial
use, costs slightly over $300 for an indie license if you wish to sell your
work. There are student versions of Visual Studio available but they can
have restrictions on using the product for commercial use. There are express
editions available that do not have this restriction, but once again they require
additional setup to make nFringe work correctly. All told to have the ideal
setup that you can use for commercial work will cost money. However if you
have the financial resources or do not wish to sell your work, then nFringe is
a good choice.

WOTgreal is another popular choice for UnrealScript editing. At the time
of this writing contains ”initial” UDK support. The trial version contains a
good bit of nagging at the program start but the standard license is currently
only $25 and the professional version is only $45. Due to the nagware nature
of the trial I would recommend getting at least the standard version if you
were interested in using WOTgreal for development. Updates do not seem
very frequent but this tool has a long history of being used for UnrealScript
editing and remains a valid choice. However be warned that WOTgreal does
not seem to have UDK debugging capabilities and so I would really only
suggest it as an option for source editing and it is not by my definition a full
IDE for UnrealScript for UDK.

ConTEXT is yet another good choice for editing UnrealScript files. It is
freeware and lightweight which means you have little to lose by checking it
out. Additionally it has highlighters for many more languages than just Un-
realScript so learning this tool will prove a nice addition to your development
arsenal. Keep in mind that it is just a source editor so you will still need to
use a separate debugger and to compile your scripts separately.
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UnrealDebugger is a debugging utility that at the time of this writing has
just recently been released that provides UnrealScript debugging capabilities.
It supports breakpoints, error highlighting, monitoring variables, and even
compiling UnrealScript.

Keep in mind that this is not a complete list of tools available and new tools
are currently being developed and tested. If I have neglected to mention a
tool here it does not mean that that tool is not worth checking out.

For now I am going to show how to setup and get the source editing tools that
are available and we will cover compiling and debugging in a later chapter.
After showing how to use all of the choices we will opt to use nFringe and
Visual Studio as it remains the most popular choice. Keep in mind that since
this book is about programming in UnrealScript, the concepts will still apply
regardless of which tools you choose to use.

1.2.1 Using nFringe with Visual Studio

nFringe can be downloaded from PixelMine at the following URL: http:

//pixelminegames.com/nfringe/. The website contains directions on how
to install the nFringe plugin depending on what (if any) version of Visual
Studio you currently have installed. If you are using Visual Studio 2008
or higher then there should be no additional steps but to run the nFringe
installer (although you will need to make sure you have the .NET framework
3.5 SP1 installed first). If you are using Visual Studio 2005 then you will need
to download ProjectAggregator2 first. The latest version of Visual Studio
can be purchased from Microsoft or can be purchased from an academic
store if you are currently a student. If you are a student then check to see
if your degree and school participate in the Microsoft Academic Alliance as
you can typically get Microsoft Visual Studio for free or very cheap. If you
are using any of the express editions of Visual Studio products, or if you
do not currently have any editions installed, you will need to download the
Microsoft Visual Studio 2008 Shell (Although this may be updated in the
future to higher versions of Visual Studio) before you can run the nFringe
installer. Keep in mind that the installation directions at PixelMine state
that you MUST restart your computer after installing the Microsoft Visual
Studio 2008 shell before running the nFringe installer. Similar instructions
and related downloads can be accessed by navigating to the wiki from the
nFringe page at PixelMine. I will neglect to give full links for fear that they
could break in the future if PixelMine reorganizes their website.

http://pixelminegames.com/nfringe/
http://pixelminegames.com/nfringe/
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Once nFringe is successfully installed we can go about setting up nFringe for
UDK. The PixelMine wiki has an entry on setting up an nFringe project and
it provides download links to a project file and script modifier that are to
be placed in the Development\Src and Development\Src\Core directories re-
spectively. The project file is a shortcut for having to create an UnrealEngine
3 Licensee project and the ScriptModifiers file tells nFringe which keywords
should be highlighted in the UnrealScript for UDK.

1.2.2 Using WOTgreal

WOTgreal can be downloaded from http://www.wotgreal.com/. It is prob-
ably the easiest option to setup as it is a self contained program. One nice
feature of WOTgreal is an UnrealScript specific class browser. It is worth
noting that there is a separate registry cleaner program that comes with
WOTgreal that can be used to clear things like the recently opened files and
this can be a life saver if you run into problems! Also note that you will
need to go to Options-> Preferences from the main menu and configure the
UDK directories. The root directory is the main folder of your current UDK
build, the source root folder is under \Development\Src\. You will also need
to specify the UCC.exe file which for UDK is actually UDK.com and it is
found in the \Binaries\Win32 or \Binaries\Win64 directories depending on
whether you wish to use the 32 bit or 64 bit version of UDK. After updating
the directories you can right click the package explorer and select Refresh
Class\Package tree from the resulting context menu. You will also want to
make sure you are using extends instead of expands. WOTgreal features
good code completion and once you get it setup correctly it is a fairly nice
tool.

1.2.3 Using ConTEXT

ConTEXT can be downloaded from http://www.contexteditor.org/. The
download page has a link to a list of available highlighters and UnrealScript
is among those listed. You will have to manually place this file in the High-
lighters directory. Also note that this editor is very simplistic and does
not contain code completion and class browsing capabilities like nFringe and
WOTgreal. To use this editor you will need to open each source file that you
wish to edit individually and UnrealScript source files have the file extension
.uc. This means in order to create new classes you will need to make a new

http://www.wotgreal.com/
http://www.contexteditor.org/
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Figure 1.1: - WOTgreal configured for UDK. Some sources suggest not using
the UDK game type and instead using the UT3 game type. Experiment and
see which works for you. Support for UDK may not be perfect, but it is still
a good editing program.
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file and save it with the uc file extension where the name of the file would be
the name of your class.



Chapter 2

Our first UnrealScript class

2.1 Object Oriented Programming in Unre-

alScript

UnrealScript is by design an object-oriented (OO) language. Every source
file contains exactly one class and each class extends an existing UnrealScript
class. It is for this reason that we must talk about object-oriented program-
ming (OOP) techniques and concepts before we discuss more basic and fun-
damental programming concepts. If you have learned programming from
other books then my approach might seem opposite tradition, however I feel
it is the only way to provide a fair introduction to the world of UnrealScript.
If you are left wondering what exactly objects are or what object-oriented
means, then I will do my best to provide a basic explanation, however you
may need to find additional materials if you remain confused. Whole books
can be written on the subject of object-oriented programming alone, however
to do so would not allow time to discuss more interesting and practical uses
of UnrealScript for UDK.

An object when used in the context of object-oriented programming refers
to a combination of methods and attributes that are used to represent an
entity. For example we could have a car object that contained an attribute
for the amount of fuel in the gas tank and a method for making the car
accelerate. Fields store data and methods act on these fields to perform
meaningful tasks. Objects are typically designed to be reusable or written in
such a way that they are able to be reused from program to program.

In UnrealScript and other languages a class serves as the blueprint for our

8
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object and we can create new instances of our object based on this class
using the keyword new. Some languages have what are known as constructors
which are called when a new instance of an object is created, but UnrealScript
does not have this. Instead we can initialize attributes in our object to default
values using the DefaultProperties block in an UnrealScript file.

A class is like the model of a particular car. So if we had a Ford Mustang class
then we could create instances of that class in a factory. Each instance refers
to a particular Ford Mustang and so if we fill it up or make it accelerate those
changes will only affect that particular Mustang and not all Ford Mustangs
as a whole. Expanding on this analogy further we can see that the Ford
Mustang is a particular case of car, so we could have the Ford Mustang
extend the Car base class. By extending a class we gain its functionality and
are able to make changes to how specific functionality is implemented. While
the car may implement an accelerate method, the Ford Mustang class can
further dictate what happens when the car is accelerated (such as updating
the motor RPM gage, ect).

I understand that this all might still be quite confusing so I hope the concepts
will become clearer with practical UnrealScript examples. If you are still
confused then it should be easy to find excellent books or internet articles on
object-oriented programming. UnrealScript is similar to Java so if you find
resources targeting that language most of the concepts should apply.

2.2 Creating a Cheat Manager class

We are going to begin our UnrealScript adventures by creating a basic class
that will allow us to experiment with basic programming elements. I will
show how to create this class in nFringe, WOTgreal, and ConTEXT so that
you will have a basic idea of how to use each tool. I will highly recommend
using nFringe or WOTgreal due to the code completion capabilities as I find
it to be a massive help when programming especially if you are not an expert
at the syntax.

At first we are going to be working with the UTGame classes provided with
the UDK installer. We are not going to modify these classes directly, but in-
stead we are going to extend the existing cheat manager’s functionality with
a few new methods and attributes. The reasoning is that these classes could
very easily be refactored in later releases and by modifying the UTGame
classes we could force ourselves to have to manually add our changes back
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to these files later and that is if we don’t accidentally lose the changes we
made to begin with. Also creating our own class will provide valuable expe-
rience.

UTGame provides a framework for a first person shooter game based on
the Unreal Tournament series of games and the cheat manager class deals
with managing cheat codes entered into a developer console. When you run
UDK.exe to play the game you can hit the tilde character to access the
developer console. The cheat manager defines various cheat codes that can
be entered into this developer console and controls what happens when the
cheat code is successfully entered. This is perfect for playing with beginning
programming concepts as it will allow us to pass parameters to our defined
cheat codes and to output the results to the development console. However
at first we are not going to output to the developer console but a log file that
we can use for debugging purposes. Learning to read and understand this
log file will serve you well as you develop games in UnrealScript.

We have two objectives, the first is to create a new class that extends from
the UTCheatManager class and to modify our UTPlayerController class to
use our new cheat manager instead of the old one. I know that modifying the
existing UTPlayerController class goes against what I said earlier, however
this change is a single line change and it is merely for testing purposes.
Sometimes I will do such things for the sake of time and brevity just know
that it is not the best practice and avoid doing it when possible. In a later
chapter we will look at making our own simple framework that does not rely
on UTGame at all but instead uses the UDKBase classes.

2.2.1 Creating the class using nFringe

To create the UTCustomCheatManager class using nFringe and Visual Stu-
dio, the first step we will take is to launch the UnrealScript solution in the
\Development\Src folder that you should have retrieved from the PixelMine
website as part of the nFringe setup process. We see what the UnrealScript
project looks like initially when opened in figure 2.1.

We can now navigate in the Solution Explorer to find the UTGame folder.
Each folder in the Src directory is an UnrealScript package and we expand
this folder/package we will see a subfolder labeled Classes. All UnrealScript
classes belonging to the particular package must go inside of of this Classes
subfolder. When we expand the Classes sub folder we will see hundreds
of UnrealScript class files but do not be intimidated! The good thing about
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object oriented programming is that we are able to logically break down huge
code bases and focus only on a very small part of that code base at a time. We
do not need to worry about ALL of the classes listed in the Classes subfolder,
only those that are important to our immediate goals. Over time you will
learn more of these classes and maybe even model some of your very own
classes based on classes contained in the UTGame package. It is an excellent
example of how to get work done in UnrealScript for the UDK.

Make sure the Classes subfolder is selected in the Solution Explorer and then
select Project->Add New Item from the main menu or press Ctrl+Shift+A on
your keyboard. This will open the Add New Item dialog. Select UnrealScript
File as the file type and enter UTCustomCheatManager for the class name.
Your dialog should look similar to the dialog in figure 2.2. Click the Add
button in the dialog to create the new class file. We will now be taken to the
Visual Studio source editor and we should see our newly added class ready
for editing.

Figure 2.1: - Visual Studio 2010 showing the UnrealScript project provided
by PixelMine for use with nFringe.

Your code will look something like listing 2.1.

Listing 2.1: UTCustomCheatManager extending Object in nFringe.

1 class UTCustomCheatManager extends Object;
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Figure 2.2: - The Add Item dialog in Visual Studio 2010 showing the Unre-
alScript File type selected and the name UTCustomCheatManager.
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2

3 DefaultProperties
4 {
5 }

The problem with this current code is that we are not extending from the
UTCheatManager but the Object class. We need to be extending from
UTCheatManager so that we can gain the functionality that is already de-
clared in the UTCheatManager class. We will modify the code as follows in
listing 2.2.

Listing 2.2: UTCustomCheatManager extending UTCheatManager in nFringe.

1 class UTCustomCheatManager extends UTCheatManager;
2

3 DefaultProperties
4 {
5 }

We replaced Object with UTCheatManager so we can inherit the function-
ality defined in the UTCheatManager class. Our UTCustomCheatManager
class will be able to add or modify attributes and methods of the UTCheat-
Manager.

2.2.2 Creating the class using WOTgreal

The easiest way to create the class in WOTgreal is to right click the UTGame
package in the Package explorer and select Create Sub Class from the context
menu. We can enter the parent of the class to be UTCheatManager, enter
the name of our class as UTCustomCheatManager, and make sure that we
are using Extends instead of Expands. An example of this setup can be seen
in figure 2.3.

Alternatively we could create a new UnrealScript file, write out the class
definition and default properties manually, and then save the script file in
the classes folder under UTGame as UTCustomCheatManager.uc.

Listing 2.3 shows the class definition that will be generated or should be
typed for either approach.

Listing 2.3: UTCustomCheatManager class declaration in WOTgreal.
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Figure 2.3: - Adding the UTCustomCheatManager sub class to the UTGame
package in WOTgreal.

1 //

-----------------------------------------------------------

2 //

3 //

-----------------------------------------------------------

4 class UTCustomCheatManager extends UTCheatManager;
5

6 DefaultProperties
7 {
8

9 }

The lines preceded by two forward slashes // are comments in UnrealScript.
Comments are not interpreted to be code and so we are free to put notes
about how the particular code we are working on functions or what purpose
the code has. It is good programming practice to write comments that spec-
ify what a particular piece of complex code does and a description of the
algorithms involved. I do not recommend commenting each line of code or
writing obvious comments. In general your comments should provide a high
level overview of methods in your code so that an outside reader (or yourself
in the future) can understand the basic thought processes behind your design.
At a deeper level your code should be self documenting by using descriptive
variable, method, and class names. Here the comments were automatically
inserted into our code as part of the WOTgreal class template.
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2.2.3 Creating the class using ConTEXT

Using ConTEXT to create the class is fairly straight forward. Create a new
file and select UnrealEd as the source highlighter. Type the code in listing 2.4
and save the file as UTCustomCheatManager.uc in the Classes subfolder of
the UTGame package (All of the folders inside of Development\Src\ are Unre-
alScript packages.). So in other words save the UTCustomCheatManager.uc
file to [YourUDKInstallDirectory]\Development\Src\UTGame\Classes.

Listing 2.4: UTCustomCheatManager class declaration in ConTEXT.

1 class UTCustomCheatManager extends UTCheatManager;
2

3 DefaultProperties
4 {
5 }

Your editor should look similar to figure 2.4.

Figure 2.4: - The UTCustomCheatManager class definition in ConTEXT.

2.3 UTCustomCheatManager class definition

in more detail

Regardless of which source editor you use to work with UnrealScript you
should have a similar UnrealScript class declaration for UTCustomCheat-
Manager. Listing 2.5 shows the important code.
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Listing 2.5: UTCustomCheatManager class declaration.

1 class UTCustomCheatManager extends UTCheatManager;
2

3 DefaultProperties
4 {
5 }

The first line in an UnrealScript file declares the class and the class parent.
Every UnrealScript file contains exactly one class and every UnrealScript
class must extend an existing class. This concept is called inheritance and
it enables you to modify the functionality of an existing class by redefining
class methods, altering variables of the base class, and adding new variables
and methods. This design is supposed to motivate you to not reinvent the
wheel. Instead of writing a class from scratch, try to extend an existing class
that is close to the functionality that you need!

It is worth noting that you are not able to extend from more than one class
in UnrealScript. The concept of multiple inheritance is not supported and
chances are if you feel that you need multiple inheritance you should con-
sider composition instead. I will briefly discuss composition in a later chap-
ter.

The next line which in our listing is on line three is our DefaultProperties
block. In between the DefaultProperties brackets we can specify the default
properties that our class attributes should be initialized to when we create a
new instance of our class.

2.4 Exec functions

In order to add a new cheat code to our cheat manager we will need to
create a new method for our UTCustomCheatManager class. We can define
a new method using the keyword “function”. Often times the terms method
and function are used interchangeably in programming. However I am using
method to refer to a function pertaining to an object in which we expect
an object reference as an implicit (implied but not fully expressed, as in
not visible but handled behind the scenes and passed for us) parameter.
Functions can be defined in other languages that are not part of an object,
and so to avoid confusion I will use the term method when talking about a
function that is part of an object.
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There are a number of specifiers we can use before the function keyword
in UnrealScript. One such specifier is the exec specifier which stands for
executable. When we say that we have an exec function we are stating that
the function can be executed by typing the name of the function into the
Unreal console. The UDK documentation notes that this specifier is only
valid in certain situations but this is a situation in which we can use it.
Another very important feature of exec functions is that they can be bound
to keyboard keys and other input events!

We need to add the definition for this method between the class declaration
and the defaultproperties block.

Listing 2.6: Exec function added to UTCustomCheatManager class

1 class UTCustomCheatManager extends UTCheatManager;
2

3 // defines the cheat code HelloWorld with no parameters

4 //this method is executable by the Unreal console

5 exec function HelloWorld ()
6 {
7

8 }
9

10 DefaultProperties
11 {
12 }

Listing 2.6 adds the exec function HelloWorld and some comments to specify
what the function does. Hello World is traditionally used in introductory
programming tutorials as it is often one of the easiest programs to accomplish.
This cheat code will eventually display “Hello World!” when this cheat code
is executed in the Unreal console. However before we learn how to output to
the console we should learn how to output “Hello World!’ to the UDK log.
The log is extremely valuable because it contains a high degree or information
about what is going on behind the scenes when your UDK game is running.
Often you will see errors and information in the UDK log that does not appear
in game. I believe it is important that you learn to write to and access the
log file now so that you can make regular use of it for later programs and
debugging.

To output to the log we can use the log macro. The log macro has a single
string parameter which contains the text that you wish to write to the log.
String literals in UnrealScript are surrounded in double quotes ”. Macros in
UnrealScript are prefixed by the backtick character (or grave accent) `. The
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modified code is shown in listing 2.7.

Listing 2.7: HelloWorld with logging

1 class UTCustomCheatManager extends UTCheatManager;
2

3 // defines the cheat code HelloWorld with no parameters

4 //this method is executable by the Unreal console

5 exec function HelloWorld ()
6 {
7 ‘log("Hello World!");
8 }
9

10 DefaultProperties
11 {
12 }

So now when we type HelloWorld into the Unreal console we will output
“Hello World!” to the log. Save your work! In some cases you may need
to specify that you want to save this file as UTCustomCheatManager.uc in
[YourUDKInstallDirectory]\Development\Src\UTGame\Classes.

The next thing that we need to do is to update the UTPlayerController to
use our new cheat manager class. Open UTPlayerController.uc and scroll
down to around line 4,109 until you see the code in listing 2.8.

Listing 2.8: DefaultProperties for UTPlayerController

1 defaultproperties
2 {
3 DesiredFOV =90.000000
4 DefaultFOV =90.000000
5 FOVAngle =90.000
6 CameraClass=None
7 CheatClass=class ' UTCheatManager '
8 InputClass=class ' UTGame.UTPlayerInput '
9 LastKickWarningTime = -1000.0

10 bForceBehindview=true
11 DamageCameraAnim=CameraAnim ' FX_HitEffects.DamageViewShake

'
12 MatineeCameraClass=class ' Engine.Camera '
13 bCheckSoundOcclusion=true
14 ZoomRotationModifier =0.5
15 VehicleCheckRadiusScaling =1.0
16 bRotateMiniMap=false

We need to edit the following line:
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Listing 2.9: CheatClass default value

1 CheatClass=class ' UTCheatManager '

CheatClass is defined to only allow classes that are or extend the CheatMan-
ager class. UTCheatManager does extend CheatManager and we extend
UTCheatManager with UTCustomCheatManager, so we are able to spec-
ify that we want to use UTCustomCheatManager instead of UTCheatMan-
ager.

Keep in mind that the DefaultProperties block has a different syntax than
standard UnrealScript. Actors are spawned using the Spawn function but
things that are not actors (like our CheatManager) must be created using
the new operator. We have to specify the class to be created and UnrealScript
likes to store which class to be created as a class reference variable instead
of defining it directly in the code. This allows us to customize which class
is being used and it all works due to the magic of polymorphism. Briefly
polymorphism is talking about how all of the allowed class types share a
common interface and so a class that extends CheatManager is expected to
respond to the same method and attribute calls. An analogy would be how
you can connect a monitor that to your computer that was created after your
computer was manufactured due to the fact that the monitor implements a
standard interface that the computer expects. The computer does not care
that your monitor was manufactured later and does not need to know the
specifics of the monitor so long as the monitor responds to and implements
the proper interface (DVI even stands for Digital Visual Interface and HDMI
stands for High Definition Multimedia Interface!). In a similar way Unre-
alScript does not care that UTCustomCheatManager was created after the
code of the UTPlayerController was written so long as UTCustomCheatMan-
ager behaves according to the CheatManager interface.

We need to change the CheatClass to use our UTCustomCheatManager like
in listing 2.10.

Listing 2.10: UTCustomCheatManager in UTPlayerController

1 CheatClass=class ' UTCustomCheatManager '

Save your changes to this file and we are ready to compile the UnrealScript
classes and test our work!
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2.5 Building our code

2.5.1 Using nFringe

If you are using nFringe then you can simply hit F5 on your keyboard to start
debugging or go to Debug->Start Debugging from the main menu. Visual
Studio will automatically build our source files and launch UDK so that we
can test our game. An advantage to this approach is that the output window
in Visual Studio will display the contents of the log as it is being written,
which is very advantageous!

2.5.2 Using WOTgreal or ConTEXT

If you have WOTgreal and hit F9 then we will launch UDK.com which will
prompt us that our scripts are outdated and if we would like to rebuild them.
If you are using ConTEXT or some other source editor then you will need
to use Unreal Frontend to compile your files. By trying to launch UnrealEd
from within the Unreal Frontend we will be prompted if we want to rebuild
our script files as in figure 2.5 and the same thing will happen if we run the
UDK.com file from the Win32 or Win64 folder. The outdated script dialog
looks like figure 2.6.

Click yes to compile our script files as Unreal packages. The UDK comman-
dlet should show success when the scripts are compiled as in figure 2.7. Once
the commandlet is finished we can close the commandlet and run UDK.com
again by pressing F9 in WOTgreal or running it directly to launch our game.
We can launch UnrealEd and test our changes that way, however testing our
code in UnrealEd will require an additional step as we must specify what
game type to use.

In UnrealEd we will need to edit the world properties to specify which game
type to use for our level. The world properties refer to the specific prop-
erties for our level contrary to what the name might suggest. Navigate to
View->World Properties from the main menu and you should see the world
properties dialog. Locate the Game Type section and select UTGame for
Default Game Type and Game Type for PIE as in figure 2.8.

We can press F8 or right click in the level and select Play from Here from
the context menu to play our game.
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Figure 2.5: - Unreal Frontend.

Figure 2.6: - Outdated script dialog.
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Figure 2.7: - UDK UnrealScript compiler commandlet.

Figure 2.8: - Editing Game Type in WorldInfo properties.
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2.6 Testing our cheat code

When we are playing the game we can hit the tilde key �to access the Unreal
console. Type “Hello World” and press Enter on your keyboard in order to
activate this cheat code. The results are shown in figure 2.9. The results of
our cheat code are not obvious as we did not output to the console, but a log
file. If you are running nFringe then you should be able to observe the results
of this cheat code by looking at the Visual Studio output window.

Figure 2.9: - The cheat code HelloWorld typed into the Unreal console.

The Unreal log file is stored in the [YourUDKInstallDirectory]\UDKGame\Logs
folder and is named Launch.log. Open this log file in a text editing program
and you should see something similar to listing 2.11 if you scroll towards the
end of the log file.

Listing 2.11: The Launch.log file

1 [0041.02] Log: Assembled 403 auto -complete commands , manual
: 83, exec: 273, kismet: 0

2 [0043.05] Cmd: HelloWorld
3 [0043.05] ScriptLog: Hello World!
4 [0048.35] Cmd: onrelease ShowMenu

If you are using UnrealEd you may need to play in editor twice in order
for the log to update fully. I wanted to show the log because as you read
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through it you will see a lot of information that is not obvious when running
the game. You may even see errors occurring that you did not know about!
Make a habit of reading your log file as it can save you a lot of headache
during development!

Another option is we can launch UDK.exe with the -log command line argu-
ment. This will allow us to view the log in a console window as it is being
written!

2.7 Writing to the console

I have to admit though that our current cheat code is not very fun. We
do not immediately see results and checking the log each time just to see a
text response would get very tedious. Even if we use the log command line
argument we still have to switch windows, and it can be hard to find the
right log entry in the flood of messages.

We happen to be in luck because UTCheatManager extends CheatManager
within PlayerController. The within keyword specifies that UTCheatMan-
ager should be created within PlayerController, and the PlayerController
class variable is passed to the CheatManager when a new instance of it is
created. This class variable is stored in a variable called Outer which will
allow us to access the PlayerController class. This is good news because
PlayerController has a nice method for outputting messages to the console
called ClientMessage. The revised code is shown in listing 2.12.

Listing 2.12: ClientMessage in HelloWorld cheat code

1 class UTCustomCheatManager extends UTCheatManager;
2

3 // defines the cheat code HelloWorld with no parameters

4 //this method is executable by the Unreal console

5 exec function HelloWorld ()
6 {
7 Outer.ClientMessage("Hello World!");
8 }
9

10 DefaultProperties
11 {
12 }

Here we are calling the ClientMessage method of the PlayerController clas
which we passed when we created the instance of the CheatManager inside
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the PlayerController. Outer is already expected to be of the correct type.
Some people choose to omit Outer and instead type ClientMessage. If the
compiler can not resolve ClientMessage as a method of the CheatManager
class it will attempt to prefix an Outer. to the ClientMessage method. I
recommend writing out Outer. because I feel it makes the code easier to
understand.

ClientMessage like the log method takes one string parameter. Remember
that double quotes in UnrealScript surrounding text specify a string literal!
Save your work, rebuild your code, and test out the revised cheat code! You
should see an output similar to figure 2.10.

Figure 2.10: - Writing to the console using the ClientMessage method.

We are now in a position where we can experiment with various flow control
statements in UnrealScript!
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Book Preview

3.1 Thank you!

I hope you enjoyed the preview for my currently in development book Unre-
alScript fundamentals for the UDK! If you find any errors, have any concerns,
or would like to provide me with suggestions for what to include in this book,
do not hesitate to visit my website! You will be able to see the latest status
on the book and eventually find out where to purchase it!

http://www.donaldsmay.com/books/unrealscript-fundamentals/

Thank you for reading, and I hope to have the book available soon!
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